WinTerm
Universal
Terminal
Program
ID No.
29890 BA2
Rev. No. 01 25.11.96

WinTerm

Contents

CONTENTS
1. INTRODUCTION
1.1 Use and Function
1.2 Typographical Conventions

1-1
1-1
1-2

2. PROGRAM STRUCTURE
2.1 The Main Menu
2.2 The Instrument Menu
2.3 The Terminal Menu
2.4 Program Handling
2.5 Sequence of Operations (Quick Start)
2.6 Menus and Functions Overview

2-1
2-1
2-2
2-3
2-4
2-6
2-7

3. PROGRAM FUNCTIONS
3.1 Instrument Definition
3.2 Editing Instrument Parameters
3.3 Instrument Communication
3.3.1 Data Transfer
3.3.2 Instrument Control via Function Keys
3.3.3 Data Communication Parameters Display
3.3.4 Downloading
3.4 Terminal Emulation
3.5 Documentation of Program Functions
4. INDEX

3-1
3-1
3-12
3-13
3-15
3-17
3-17
3-17
3-18
3-21
4-1

I

WinTerm

1. Introduction

1. Introduction
1.1 Use and Function
WinTerm is a universal terminal program designed by EG&G
Berthold for control and communication with (nearly) all standalone instruments that feature data output via the serial interface.
WinTerm is a 32 bit Windows 95 MDI application; with Win32s it
can also run under Windows 3.1 and Windows for Workgroups
3.11.
Major WinTerm functions:
 Terminal emulation for ANSI, TTY, VT52, VT100.
 Instruments definition via dialog for setting the communication
parameters.
 Control of stand-alone instruments via WinTerm by means of
function keys that can be defined by the user as needed.
 Importing instrument data into WinTerm; data strings can be
modified easily as needed in order to process the data in external programs.
For example, you can define separators or modify or skip any
character to get the desired table format.
 OLE automation for direct import of the data into EXCEL 5.0
(and higher).
 Downloading of files, i.e. transfer of files to the stand-alone instrument (e.g. for program updates).
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1.2 Typographical Conventions
We have used the following symbols consistently in order to
make it easier to work with the Manual:
Menu titles, options, dialog boxes and tabs are written in bold
type inside square brackets [ ].
Example: [File] menu, [Communication Setup] dialog box,
[Terminal Settings] tab.
Parameter queries on a tab are also printed in bold type inside
square brackets [ ].
Example: [Baudrate]
Buttons and function keys are printed in bold type inside pointed
brackets < >.
Example: <OK>, <Remove>
Entries by the user are printed in bold type inside quotation
marks.
Example: input of instrument name in the [Name] field: "LB
9507".
The control characters in the [Control Codes] list ([Script
Language] tab) already have pointed brackets; they are printed
in bold type together with the pointed brackets.
Example: <NUL>, <LF>.
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2. Program Structure
WinTerm comprises three levels:

2.1 The Main Menu
File

View

Connect

Terminal

Open

Toolbar

Connect Instrument

Terminal Emulation

Print Setup

Statusbar

Add Instrument

Add Terminal

Modify Instrument

Modify Terminal

Communication Setup
dialog box

Instrument
select window

Communication Setup
dialog box

Instrument Drivers

Instrument
menu

Terminal
select window
Terminal Drivers

Terminal
menu

Major functions
of the main menu
Defining/establishing communication with instruments
The [Connect] menu includes two different instrument-specific
functions.
 Via [Add] and [Modify] you can define or edit the communication parameters specifically for an instrument in the [Communication Setup] dialog box and save them under the instrument name, e.g. transfer parameters, definition of function
keys for instrument control, string processing.
 [Connect Instrument] takes you via the Instrument select
window (and you can select a defined instrument) to the Instrument menu and you can communicate with the connected instrument.
Terminal emulation
On the [Terminal] menu you can define parameters for the desired terminal emulations specifically for an instrument (items
[Add Terminal]/[Modify Terminal]) and save them.
[Terminal Emulation] on the [Terminal] menu takes you via the
terminal select window to the Terminal menu where the data
flow is displayed.
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2.2 The Instrument Menu
File
Open
Close
Save
Save As
Print
Print Preview
Print Setup
Exit

Edit
Undo
Cut
Copy
Paste

View
Toolbar
Statusbar

Connect
Disconnect Instrument

Extras
Options
Send File

Instrument xy

Select [Connect Instrument] on the [Connect] menu and then
choose an instrument in the Instrument select window to get to
the Instrument menu.
Major functions
of the Instrument menu
The communication with the selected instrument is displayed in
an instrument-specific window. Upon completion of the transfer,
you can edit the data displayed in the Instrument window using
the functions of the [Edit] menu and save and print them using
the functions of the [File] menu.
[Options] on the [Extras] menu takes you to the instrumentspecific [Communication Setup] dialog box; you can view and
edit the parameters for display in the Instrument window (terminal
parameters, communication parameters and function key definition).
Use the [Send File] item to download files to the connected instruments.
[Disconnect] on the [Connect] menu terminates the connection
with the instrument and you can use the editing functions. You
can reestablish a connection with the instrument via the [Connect] item on the [Connect] menu. When you close the Instrument window, the program returns to the main menu.
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2.3 The Terminal Menu
File
Exit

Edit
Undo
Cut
Copy
Paste

View
Toolbar
Statusbar

Terminal
Close Terminal

Extras
Options
Send File

On the Terminal menu, the data flow is displayed depending on
the selected terminal emulation. Select [Options] on the [Extras]
menu to view and edit the communication parameters and the
function key definition ([Communication Setup] dialog box).
Select [Close Terminal] on the [Terminal] menu to terminate the
terminal mode .
[Send File] allows you to send data to the connected instrument.
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2.4 Program Handling
WinTerm is operated using typical Windows or Windows 95 conventions either by clicking on the menu title or function name or
by typing the underscored letters while holding down the <Alt>
key.
In dialog boxes comprising several tabs you select the tab you
want by clicking on it.
The WinTerm toolbar comprises 8 buttons. You can select individual program functions directly without having to open a menu
window first.
WinTerm toolbar (from left to right):

Open file
Save file
Cut highlighted text
Copy text to Clipboard
Paste text from Clipboard
Print file
General online help
Context-sensitive help

Dimmed (gray) buttons mean that the program is in a status that
does not permit you to select the respective function.
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Working with Instrument windows
Scroll bar
The Instrument window includes a vertical scroll bar at the right
hand margin of the window, so you can scroll the contents of the
window up or down. You can drag the scroll box with the mouse
in the desired direction.
Click on the respective arrow button
dow contents up or down row-by-row.

or

to scroll the win-

Buttons
The buttons in the upper right corner of the window have the following function:
Clicking on this button ends the instrument connection and closes
the Instrument window. The program returns to the main menu.
Enlarges the Instrument window to fill up the entire screen.
Clicking on this button reduces the Instrument window to an icon.
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2.5 Sequence of Operations (Quick Start)
1. Install program via Setup program.
2. Define instruments in the main menu
Select [Add Instrument] on the [Connect] menu, and enter
the instrument-specific communication parameters in the
[Communication Setup] dialog box for the desired instrument. See the operating manual of the respective instrument
for more information (transfer parameters, structure of data
strings output to the serial interface of the instrument, external
control option).
Confirm entries with <OK> .
Repeat this procedure for each instrument.
3. Establish instrument communication
Connect instrument to serial interface.
Select [Connect Instrument] on the [Connect] menu and
then select the instrument you want in the Instrument select
window. The program changes to the Instrument menu and an
empty window opens showing the instrument communication.
If external instrument control is possible and function keys
have been defined in the [Communication Setup] dialog box
, these function keys are shown at the bottom of the screen.
If you have defined OLE automation, EXCEL is started and a
window opens showing an empty spreadsheet. If you have a
17" screen, EXCEL and the Instrument window can be displayed at the same time.
4. Start instrument communication
a) External control
Communication starts as soon as you press the Start function
button. The further sequence of operations is dependent upon
the individual instrument.
b) Instrument control
Communication is established as soon as the connected instrument sends data via the serial interface, i.e. when the instrument is operated accordingly and a measurement has
been started. This data is imported into the Instrument window
and - if selected - into the EXCEL spreadsheet.
5. Select Terminal emulation in the main menu (optional)
Select [Add Terminal] on the [Terminal] menu and define the
desired terminal emulation(s). Then select [Connect Terminal]. As soon as you select the connected instrument, the data
flow is displayed in the Terminal menu.
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2.6 Menus and Functions Overview
Main Menu
File

View

Connect

Terminal

Open

Toolbar

Connect Instrument

Terminal Emulation

Print Setup

Statusbar

Add Instrument

Add Terminal

Modify Instrument

Modify Terminal

Communication Setup
dialog box

Instrument
select window

Communication Setup
dialog box

Instrument Drivers

Terminal
select window
Terminal Drivers

Instrument Menu
File
Open
Close
Save
Save As
Print
Print Preview
Print Setup
Exit

Edit
Undo
Cut
Copy
Paste

View
Toolbar
Statusbar

Connect
Disconnect Instrument

Extras
Options
Send File

Instrument window
V
V
%

2300
4560
: :

Terminal Menu
File
Exit

Edit
Undo
Cut
Copy
Paste

View
Toolbar
Statusbar

Terminal
Close Terminal

Extras
Options
Send File
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3. Program Functions
This chapter describes the program functions in the following sequence:
1. Instrument definition
2. Instrument communication
3. Terminal emulation

3.1 Instrument Definition
You have to create an instrument-specific parameter set for each
instrument you want to communicate with via WinTerm. Enter
this parameter set in the [Communication Setup] dialog box; it is
saved as driver information. These instrument-specific files can
be loaded again any time and allow direct communication with the
respective instrument .
Procedure

1. Select [Add Instrument] on the [Connect] menu of the main
menu. The [Communication Setup] dialog box appears,
comprising 5 tabs.

Figure 3-1:
[Communication Setup],
[General] tab
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2. Select the [General] tab.
[Driver information] [Name]
Enter a name for the desired instrument. This name is also
used as filename and - with the WinTerm-specific extension
.TBB - displayed in the [Filename] text box.
[Excel OLE Automation]
Define here if you want to use OLE automation. If you select
this option, EXCEL starts automatically when communication
has been established with an instrument ([Connect Instrument]), and the incoming data is automatically imported into
an EXCEL spreadsheet.
To use this feature, EXCEL 5.0 or higher must be installed on
your PC.

3. Select the [Communications Parameter] tab (see Figure 3-2)
and enter the communication parameters for the respective
instrument. See the instrument operating manual for more information.
Figure 3-2:
[Communication Setup],
[Communication
Parameter] tab
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4. Select the [Terminal Settings] tab (Figure 3-3) and enter the
parameters for screen display:
[Terminal Mode]
[Show Control Characters]
Shows the control characters which are normally invisible
(ASCII codes 1 to 32).
[CR -> CR/LF]
Conversion of CR into CR/LF when
[Receiving]
or
[Transmitting]
or
none, when none of these options has been selected.
Figure 3-3:
[Communication Setup],
[Terminal Settings] tab
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5. Select the [Function Keys] tab (Figure 3-4) if the instrument
can be controlled via external commands. You can create
function keys and assign text, text with control character or
complete files to these function keys. If you use one of these
function keys in the Instrument menu, the files are sent to the
respective instrument via the serial interface.
Figure 3-4:
[Communication Setup],
[Function Keys] tab
You may assign one or
several files to one function
key if these files are in the
program directory. As soon
as you press the respective
function key, the file contents is sent to the instrument.
Beginning and end of the
filename have to be identified by the character ^$F.
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How to define function keys
 Enter a name in the [Key Name] column. This name appears
later on the function key.
 In the [Command] column, enter text, text with control characters and/or one or several filenames which are to be assigned
to a function key and transmitted at the push of a button.
The ^$F code must appear before and after each filename.
 Place the cursor in the respective row of the [Command] column and enter text, the control character or the filename.
Tool for entering control characters:
Place the cursor at the entry position and select the control character from the [Control Codes] list by double-clicking on. (You
can also insert a control character by clicking on the desired character and then clicking on <Add>).
 Up to 8 function keys (<F1> to <F8>) can be defined in this
manner.
Control Codes are invisible ASCII control characters (see also
the list of ASCII control characters on page 3-8).

[Show Keys]
If you select this item, the invisible ASCII control characters are
displayed for this instrument during communication.
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6. Select the [Script Language] tab (Figure 3-5).
You can modify the data string expected by the instrument
such that it can be processed by other programs (e.g. columnwise layout of the measured data, deletion of control character, adding tabs, etc.).

Figure 3-5:
[Communication Setup],
[Script Language] tab
Explanation

[Input String]
Row-wise input of control characters which are to be used by the
respective instrument unmodified or modified. Characters which
are not entered here will be disregarded. You can define modifications for each row via [Commands] and [Control] character
(see below).
[Output String]
Shows the string the way it looks after editing.
[Commands]
List of commands which can be used to change or delete control
characters:
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[Change Character]

Change Character (0, a, b)
0 = placeholder for the position to be changed (sequential position number)
a = placeholder for the character to be changed
b = placeholder for the character to which a is to be converted.

[Change Characters]

Change Characters (a, b)
a = placeholder for the character to be changed which is converted wherever it occurs in the data string.
b = placeholder for the character to which a is to be converted.

[Change Spaces]

Change Spaces (abc)
(abc) = placeholder for any string. All consecutive blank characters are replaced by the entered string. This string (abc) may
therefore contain any control character.

[Insert Character]

Insert Character (0,a)
0 = placeholder for the position to be changed (sequential position number)
a = placeholder for the character to be changed

[Remove Characters]

Remove Characters

[Skip Characters]

Skip Characters (0)
0 = number of characters to be skipped

[Trim All]

Trim All ( )
Deletes all blank characters.

[Trim Left]

Trim Left ( )
Deletes all blank characters at the start of the input string (leading
blank characters).
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[Control]
List of control characters (ASCII characters from 0 to 31) that can
be inserted.
Figure 3-6:
List of ASCII
control characters

Name

Button

Description

<NUL>
<SOH>
<STX>
<ETX>
<EOT>
<ENQ>
<ACK>
<BEL>
<BS>
<HT>
<LF>
<VT>
<FF>
<CR>
<SO>
<SI>
<DEL>
<DC1>

^@
^A
^B
^C
^D
^E
^F
^G
^H
^I
^J
^K
^L
^M
^N
^O
^P
^Q
:
^T
^U
^V
^W
^X
^Y
^Z
^[
^\
^]
^^
^_

Null
Start of header
Start of text
End of text
End of transmission
Inquiry
Acknowledge
Bell (alarm)
Back space
Horizontal tab
Line feed
Vertical tab
Form feed
Carriage return
Shift out
Shift in
Delete
Device control 1
:
Device control 4
Negative acknowledgment
Synchronous idle
End of transmission block
Canceled
End of medium
Substitute
Escape
File separator
Group separator
Record separator
Unit separator

<DC4>
<NAK>
<SYN>
<ETB>
<CAN>
<EM>
<SUB>
<ESC>
<FS>
<GS>
<RS>
<US>

Control character selection: Click on the character and then on
<Add> (or double-click) to insert the highlighted character at the
cursor position.
[Sequence]
Shows the conversion commands for the respective string row.
<Add>
Inserts the highlighted control characters at the cursor position
<Remove>
Deletes the row containing the cursor (in the [Input String] and
[Sequence] fields).
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[End of String]
Enter the last character of the entire string. If this field is empty,
the last character of the selected input string is automatically
used as the last character.
[Registered Input String]
Select this option if you want to display only the defined input
strings.
How to change the input string
 Check the structure of the data transfer of the respective instruments; you can find it in the respective operating manual
or have it displayed in the Terminal mode of WinTerm.
Figure 3-7:
Example of data output
by the LB 9507

Example: LB 9507
Data output via serial interface is described in the operating
manual on pages 11-2. The first rows:
Start measuring series:
?
<Prot.No>
(CR) (LF)
<Gen. Note>
(CR) (LF)
Measured standards
<RLU>
:
:
:

(CR) (LF)

3-digits
0-15 characters

for all
NSB
TOTAL
Standard/CAL
12 digits

etc.

 Prepare those parts of the data string you want to transfer and
the modifications you want to make, so that the data can
automatically be imported in an EXCEL spreadsheet.

Keep in mind:
a) If you have selected [Registered Input String], only those
characters are processed by WinTerm and shown in the Instrument window or imported in the EXCEL spreadsheet
which have been entered and/or edited in the [Input String]
text boxes. The program disregards all characters and sequences which were not entered.
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b) During data communication, the program searches the entire
data flow for the sequences entered in the [Input String] field.
All (independent of the position in the string) sequences found
are processed and output accordingly. For example, if you enter (blank character)(CR)(LF), all rows having this form are
displayed (and processed, if necessary), i.e. in case of the
LB9507 all measured standards, since these start with a blank
character.
c) To make sure that even rows which do not have any code at
the start of a row can be transmitted, we recommend using a
blank character as code: In order to transmit the comment it
has to start with a blank character. The respective row in WinTerm would look as follows:
(blank character)(CR)(LF)
The advantage of using a blank character as code is that the
measured values always start with a blank space, since they
comprise 12 digits and are right-aligned.

 Enter the first sequence you want WinTerm to process into
the [Input String] text box.
Figure 3-8:
Example of input string

Example:
1st input string:

?<CR><LF>

You can make these entries via the keyboard, using the [Control] list to enter the control character. Click on a control character and then on <Add> (or double-click on the control character). This will insert the selected character at the cursor position.
a) unchanged string:
To use this string without any modification, exit the [Input
String] field. No entry is made in the [Sequence] list box. To
create a second row, position the cursor again in the [Input
String] field and change the input. A modification is regarded
as a new row.
b) changing the string
Select a command from the [Commands] list by doubleclicking on it. Then this command is displayed in the bottom
text box with the respective code for changing the input string
in brackets. Above that the code is explained. Overwrite the
placeholder depending on the selected command. You may
use the [Control] list. Then click on <Apply>. The changed
string is entered in the row [Output String] and the conversion command in the [Sequence] list.
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Changing an input string
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Example:
Change Character (0, a, b)
0 = placeholder for the position to be changed
a = placeholder for the character to be changed
b = placeholder for the character to which a is to be converted.
If you change this command code in
Change Character (1, <CR>, <HT>)
 Overwrite the 0 by a 1.
 Delete a, leaving the cursor in this position.
 In the [Control] list, click <CR> and then <Add> (or double-click <CR>). The <CR> character is inserted at the cursor position.
 Proceed in the same manner with b, but instead of b insert
<HT>.
 Click on <Apply>. The changed string is entered in the
[Output String] field, and the command sequence Change
Character (1, <CR>, <HT>) in the [Sequence] list.

Figure 3-10:
Example of changing a
string by 2 commands
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 Select the next command to change this string a second time.
Then the command code is displayed and you can modify it as
described above and enter it in the [Output String] row. Then
the command sequence for conversion is also entered in the
[Sequence] list. (All associated command sequences are displayed for each string.)
 Input of second row.
Exit the [Input String] field and set the cursor again in this
field. Thus, this row including its contents is regarded as the
next row. Change the existing text and modify it as described
above.
 In the [End of String] field, enter the last character of the entire string. If the field remains empty, the last character of the
selected input string is automatically used as the last character.
You can choose if only the rows defined in the [Input String]
field are to be displayed or all:
x
Registered Input Strings
Only the strings listed in the [Input String] field are displayed during data communication.
Registered Input Strings
The complete data flow is displayed.
Saving the instrument parameters
 When you have entered/converted all parameters and characters, confirm your entries with <OK>. This will save all parameters and data for the respective instrument under the instrument name (defined on the [General] tab).

3.2 Editing Instrument Parameters
 To correct the instrument parameters, select [Modify Instrument] on the [Connect] menu. The Instrument select window
appears.
 Select the desired file.
 The [Communication Setup] dialog box appears with the respective parameters.
 Edit these parameters as described in section 3.1.
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3.3 Instrument Communication
Connect the instrument to the serial interface of the computer and
turn the instrument on.
Load communication parameters for an instrument in WinTerm:
On the [Connect] menu of the main menu, select [Connect Instrument] and in the [Open] dialog box the filename under which
you have saved the communication parameters for the connected
instrument (extension .TBB).

Figure 3-11:
Opening an instrument
parameter file

Then the program changes to the
Instrument menu and shows the
empty Instrument window (Figure 3-12).
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Figure 3-12:
Instrument menu and
display of the Instrument
window with user-defined
function keys
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If you have selected OLE automation in the [Communication
Setup] dialog box, EXCEL starts
automatically and an empty EXCEL spreadsheet is displayed in a
window.
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3.3.1 Data Transfer
As soon as the data transfer starts, i.e. the data is transmitted
from the external instrument, the data flow is displayed - depending on the setting in the [Communication Setup] dialog box,
[Script language] tab - in the Instrument window (see Figure 313) and possibly in an EXCEL spreadsheet.
Figure 3-13:
Display of data flow in
Instrument window

Editing, saving and printing is possible only after completion
of the data transmission and selection of [Disconnect Instrument] on the [Connect] menu!
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The displayed data flow can be edited via the keyboard (overwrite, delete, enter) as well as via the following items on the [Edit]
menu:
[Copy]
[Cut]
[Paste]
[Undo]

The highlighted text is copied to the Windows Clipboard
and is available to other programs as well.
The highlighted text is cut out and copied to the Clipboard.
The Clipboard contents is pasted at the cursor position.
The last action is undone.

Save

The data can be saved under any name as TXT file. This format
can be imported in most word-processing and spreadsheet programs, so that the data can be processed further.
Select [Save as] on the [File] menu and enter the directory and
the filename of the transferred data in the dialog box.

Print

The transferred data can be printed by selecting [Print] on the
[File] menu or by clicking on the Print button in the toolbar.

Print Preview

After selection of [Print Preview], the file contents is displayed as
it will be printed. The keys at the top of the window allow you to
process the file contents using Windows standard functions.

Print Setup

Windows standard function for setting up the print parameter. For
more information consult your Windows manual.
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3.3.2 Instrument Control via Function Keys
The sequence of operations is the same as described in section
3.3.1. The only difference is that the instrument is not operated
via its operating panel but via the WinTerm function keys.

Figure 3-14
Instrument control via
function keys

3.3.3 Data Communication Parameters Display
While the data transmission of the connected instruments is displayed, you can view and edit the communication parameters for
the respective instrument in the [Communication Setup] dialog
box which is opened by selecting [Options] on the [Extras] menu
of the Instrument menu (see our discussion on page 3-1).
Function keys

3.3.4 Downloading
To download one or several files to an instrument, select [Send
File] on the [Extras] menu of the Instrument menu.
This opens the [Send File] dialog box. Select the file you want to
send. After confirmation of your selection, the files are
downloaded to the stand-alone instrument via the serial interface.
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3.4 Terminal Emulation
WinTerm can also work as a pure Terminal program and display
the raw data sent by the instrument on the screen unmodified.
First, select the appropriate Terminal mode for the instrument and
then make the connection.
1. Select [Add Terminal] on the [Terminal] menu of the main
menu. The [Communication Setup] dialog box with 3 tabs is
displayed and you can select the Terminal mode for your system (Figure 3-15) and define other instrument parameters.

Figure 3-15:
Selection of Terminal
emulation on the
[Terminal Settings] tab

2. In the [Terminal Emulation] drop-down list box, [ANSI],
[TTY], [VT52] and [VT100] are offered for selection. Select the
emulation you want and enter the following parameters for
output of the transferred data to the screen:
[Rows]
Number of row
depending on the raw data
[Columns] Number of columns output of the instrument

}

[Local Echo]
Select this option when the transmitted characters are returned by the receiving instrument. This prevents that characters are displayed twice.
[Block Cursor]
The cursor is displayed as a block when this option is selected, otherwise as a vertical line.
[Scrollbar]
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Shows a scroll bar in the Terminal window so you can scroll
while the data flow is displayed.
3. Select the [Communication Parameter] tab and enter the
transfer parameters for this instrument (see Figure 3-2, page
3-2)
4. Select the [Function Keys] tab when the instrument can be
controlled externally and define the function keys (see page 34).
5. Confirm the entries with <OK>. The program returns to the
main menu.
6. Select [Terminal Emulation] on the [Terminal] menu to start
the Terminal transmission. After selection of the desired Terminal file in the Terminal select window, the program changes
to the Terminal menu with the respective menu bar and a window showing the transmitted data (Figure 3-16). Any function
keys you have defined are displayed at the bottom of the
screen. When you press a function key, the respective text
(with control character) is sent to the selected instrument via
the serial interface. The transmitted and received character
are then displayed in the Terminal window.
7. Select [Send File] on the [Extras] menu to transmit data in the
Terminal mode to the connected instrument and select the file
you want to send from the file select window.

Figure 3-16:
Data transmission in
Terminal mode
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Save data

Editing the
communication parameters
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The data displayed in the Terminal window can be saved under
any filename. Select the item [Save As] on the [File] menu.

Communication parameters can be edited as follows:
a) On the Main menu
Select [Modify Terminal] on the [Terminal] menu and select
the desired Terminal file in the Terminal select window. The
[Communication Setup] dialog box appears showing the respective parameters.
b) On the Terminal menu
Select [Options] on the [Extras] menu. The [Communication
Setup] dialog box appears showing the respective parameters.
In both cases, you can save the changes by clicking <OK>.

WinTerm
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3.5 Documentation of Program Functions
Main menu
[File] menu
[Open]
[Print Setup]

[View] menu
[Toolbar]
[Statusbar]

[Connect] menu
[Connect Instrument]

[Add Instrument]

[Modify Instrument]

[Terminal] menu
[Terminal Emulation]

[Add Terminal]

[Modify Terminal]

Opens an Instrument or Terminal file after selection of the desired
file in the [Open File] dialog box.
Defines the print parameters in the [Print Setup] dialog box (Windows standard function).

Shows the toolbar at the top of the screen. The toolbar disappears when you click on this item once more.
Shows a status bar at the bottom of the screen. Clicking on the
item once more hides the status bar.

Select an instrument parameter file in the Instrument select window. Then the connection to the respective instrument is established and the Instrument window displayed in the Instrument
menu. If the instrument sends data, the data flow is displayed in
the Instrument window, depending on the modifications defined in
the instrument parameter file .
Creates a new instrument parameter file. The instrument parameters are entered and saved in the [Communication Setup] dialog
box. This file can then be loaded via the items [Connect Instrument] or [Modify Instrument].
Modifies an existing instrument parameter file. Selecting this item
and the desired file in the Instrument select window opens the
[Communication Setup] dialog box and you can edit the parameters.

Select the Terminal file in the Terminal select window. Then the
program changes to the Terminal menu. The connection to the
respective instrument is established and the data flow displayed
in the Terminal window.
Creates a new Terminal file. The Terminal emulation parameters
are entered and saved on the 3 tabs of the [Communication
Setup] dialog box. This file can then be loaded via the items
[Connect Instrument] or [Modify Instrument].
Modifies an existing Terminal file. Selecting this item and the desired file in the Terminal select window opens the [Communication Setup] dialog box and you can edit the parameters.
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Instrument menu
[File] menu
[Open]
[Close]
[Save]
[Save As]
[Print]
[Print Preview]

[Print Setup]
[Exit]
[Edit] menu

[Undo]
[Cut]
[Copy]
[Paste]
[View] menu
[Toolbar]
[Statusbar]

[Connect] menu
[Disconnect Instrument]

[Extras] menu
[Options]
[Send File]

Instrument window

Opens an Instrument file after selection of the desired file in the
[Open File] dialog box .
Closes an Instrument file and thus the Instrument window.
Saves an Instrument file under the existing filename.
Saves an Instrument file under a new name.
Prints the contents of the open file.
Upon selection of this item the file contents is displayed as it will
be printed, and you can edit it via buttons (Windows standard
function).
Defines the print parameters in the [Print Setup] dialog box (Windows standard function).
Exits the programs.
Editing functions for data processing in the Instrument window.
The editing functions are available only upon completion of the
data transmission and by selecting [Disconnect] on the [Connect] menu.
Undoes the last entry or action.
The highlighted text is cut and copied to the Clipboard.
The highlighted text is copied to the Clipboard.
The Clipboard contents is pasted at the cursor position.

Shows the toolbar at the top of the screen. The toolbar disappears when you click on this item once more.
Shows a status bar at the bottom of the screen. Clicking on the
item once more hides the status bar.

The connected instrument is disconnected and the editing functions for data processing in the Instrument window are available.

Shows the parameters of the loaded Instrument file. The parameters can be edited as needed.
Any file in the program directory can be sent to the connected instrument.

The Instrument window is automatically displayed in the Instrument menu. Data sent by the connected instrument is automatically displayed.
The Instrument window is closed and you exit the Instrument
menu (return to the main menu) if you click on the
the upper right corner of the screen.
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Terminal menu
[File] menu
[Exit]
[Edit] menu

[Undo]
[Cut]
[Copy]
[Paste]
[View] menu
[Toolbar]
[Statusbar]

[Terminal] menu
[Close Terminal]

[Extras] menu
[Options]
[Send File]

Terminal window

Exits the programs.
Editing functions for data processing in the Terminal window. The
editing functions are available only upon completion of the data
transmission and by selecting [Close Terminal] on the [Terminal] menu.
Undoes the last entry or action.
The highlighted text is cut and copied to the Clipboard.
The highlighted text is copied to the Clipboard.
The Clipboard contents is pasted at the cursor position.

Shows the toolbar at the top of the screen. The toolbar disappears when you click on this item once more.
Shows a status bar at the bottom of the screen. Clicking on the
item once more hides the status bar.

The connected instrument is disconnected and you exit the Terminal menu

Shows the parameters of the loaded Terminal file. The parameters can be edited as needed.
Any file in the program directory can be sent to the connected instrument in Terminal mode.

The Terminal window is automatically displayed in the Terminal
menu. Data sent by the connected instrument is automatically
displayed.
The Terminal window is closed and you exit the Terminal menu
(return to the main menu) if you select [Close Terminal] on the
[Terminal] menu.
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